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Introduction

① What is Mendeley? （1）

A FREE reference management tool for 
reading, annotations, sharing, or citing,
（Windows、Mac、Linux、iOS、Web）

You can continue to use 
Mendeley after graduation.

networking with researchers,

organize research database in cloud, 
and provide reader stats.
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Introduction

② What is Mendeley? （2）

• Support major part of manuscript writing workflow

Find and collect 
literatures

Manage and read 
literatures

Share literatures Write an article Publish an article
Send out research 
output, network

Web Importer

Online 
Catalogue

Private Group
Styled 

References

PDF Viewer, 
Annotation

Personal 
Profiles

Follow 
Researchers

Import PDF

PDF
Management

Public Group

Suggest STATS

Web

Both

Desktop
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Introduction

③ Mendeley Desktop and Mendeley Web

iOS
Android

Windows、Mac、Linux

Web

You can use Mendeley from 
anywhere.

（online and offline）

Backup

Mendeley |    6

Introduction

④ User Registration and Install Mendeley Desktop

• User Registration is required.

Step1: http://www.mendeley.com
[Get a free account] 

Step 2: First name、Last name、
E-mail、Password、[Get started]

Step 3: Choose Field of study and 
Academic Status, [Finish]

Step 5: Start Mendeley Desktop, and 
sign-in with E-mail、Password, [Sign In]

Step 4: Install Mendeley Desktop Step 6: Initial screen

＊ID for ScienceDirect applies.
＊Registration process is often updated.
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Practice / Demo

1. User Registration and Install Mendeley Desktop

2. Launch Mendeley Desktop
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Add Literatures (Mendeley Desktop)

① Import PDF, Extract Document Details

• Drag and Drop PDF files, and Mendeley Desktop will extract document details automatically.

PDF files PDF Folder

Extract Document Details

Now, you can do it 
also on Mendeley 
Web.
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Add Literatures (Mendeley Desktop)

② Watched Folder

• Mendeley will import PDF files from a designated folder.

Watched Folder settings
[File] menu → [Watch Folder…]
[Options] menu → [Watched Folders]

・・・・・
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Add Literatures (Mendeley Desktop)

③ Edit Document Details

• You can edit incomplete document details.

Edit Document Details

Import from ArXiv ID、DOI、PMID
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Add Literatures (Mendeley Desktop)

④ Manual Entry

• You can add an entry manually, and attach a PDF file.

Add document details manually.

Import from ArXiv ID、DOI、PMID

Attach a PDF file
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Add Literatures (Mendeley Desktop)

⑤ Import from other Reference Management Tool

• You can import BibTex/XML/RIS files from other tools.
- Export from other Tools

o EndNote
o [File] menu, [Export...] 
o Choose XML (*.xml) format

o RefWorks
o [Record] menu, [Export]
o Choose (EndNote,Referece Manager,ProCite)

- [File] menu, [Import…]

- Choose an exported file, and [Open]

Initial Import Page at Launch [File] menu >  [Import…]

PDF files need to be 
managed separately.
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Practice / Demo

3. Add Literatures Part 1 （Add PDF files on Mendeley Desktop）
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http://www.mendeley.com/import

Add Literatures (Mendeley Web)

① Install Web Importer（1）

• You can export literatures from databases.

Mendeley Web

Mendeley Desktop

Web Importer Install Page
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Add Literatures (Mendeley Web)

② Install Web Importer（2）

Chrome、FireFox:
Install Browser Extension

Internet Explorer、Safari:
Drag and Drop boomarklet on Tool-bar
※ Safari will use browser extension in future
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Add Literatures (Mendeley Web)

③ Use Web Importer （Chrome、FireFox）

• You can import literatures from document detail pages or search results pages.

PubMed（document detail page） PubMed（search result page）

References may be imported 
from publisher sites.

All or Selected

Opened PDF

PLoS One（document detail page）
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Add Literatures (Mendeley Web)

④ Use Web Importer （Internet Explorer、Safari）

• You can import literatures from document detail pages or search results pages.

PubMed（document detail page） PubMed（search result page）

PLoS One（document detail page）

すべてまたは選択した
文献を保存
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Add Literatures (Mendeley Web)

⑤ Direct Export to Mendeley

• Databases have ‘Export to Mendeley’ menu on web sites.

ScienceDirect

CiNii 医中誌Web

Scopus
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Add Literatures (Mendeley Web)

⑥ My Library web

• [Library] stores your collections.

Basic functions of Desktop 
Mendeley are available on 
My Library web.

Add PDF file
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Practice / Demo

4. Install Web Importer

5. Add Literatures Part 2（Web Importer）
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Synched Up

① Synch and Work in the Same Library

• Mendeley Desktop will synch up at launch or [Sync]

iOS
AndroidWindows、Mac、Linux

Web
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Synched Up

② Settings of Synch Folders

• 2GB is available FREE on Mendeley Web

Synch attached PDF file
Select folders to synch up

※ All folders are selected at defualt.

Confirm Disk Storage Spaces
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Practice / Demo

6. Synch up Mendeley Desktop with Mendeley Web
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Library Management

① Library Search and Folders

• Search, Sort Documents, Folders make it easier to manage references.

Folders

Literature Filters
（Author Keywords, Author Name, Tag, 
Publication）

Favorite

Unread

PDF file

Downloading PDF file

Library Search

Sort Documents
（Author name, Title, Publication Yea, 
Publication, Registration Date）

Add Tags
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Library Management

② Search, highlight, annotate in PDF

• You can highlight and make annotations with colors in PDF.

Search in PDF

Notes
（Library Search）

Highlight
Annotations in PDF
（Out of Library Search）
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Library Management

③ Manage PDF Files

• Windows: [Tools] menu > [Options] -> [File Organizer] tab
• Mac: [Mendeley Desktop] menu -> [Preferences…] -> [File Organizer] tab

Make PDF copies

Make named subfolders

Rename PDF files

※ All OFF at Default!

Prevents PDF 
deletion by 
mistake
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Practice / Demo

7. Organize Library and PDF files with Mendeley Desktop
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Bibliography

① Citation Style Library

• Library can use citation style.

Select Styles
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Bibliography

② Use Citation Style

• Right-click on a document, and [Copy As] → [Formatted Citation] 
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Insert Bibliography

① Install MS Word Plugin

Windows:

Mac:

Also on LibreOffice
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Insert Bibliography

② Insert Citation

Citation is inserted

Search My Library  via a pop-up 
window or

Search by Mendeley Desktop

[Insert Citation] where 
you want to insert
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Insert Bibliography

③ Reference List and Change Style

スタイルを変更

[Insert Bibliography] where you want 
to insert references

You can edit 
reference style by 

CSL Editor.

SIST02 (Japanese 
Common Style) is 

available.
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Practice / Demo

8. Insert citations and references
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Mendeley Online Catalogue

① All “My Library” Information from Users

• Your “My Library” is registered anonymously on Online Catalogue

※Select [Unpublished work] if you 
want to exclude from Online 
Catalogue.

・・・・・
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Mendeley Online Catalogue

② Mendeley Desktop

• [Literature Search], and save documents (or drag and drop).

Search Related Documents

[Save Reference]
[Save PDF]
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Mendeley Online Catalogue

③ Mendeley Web

• User Information can be found.

Related Articles

Related Articles

User Profiles (Subject 
Area, Academic Status, 
Countries）

The number of Users

[Save reference to library]
[Save PDF to library]

[Save reference to library]
[Save PDF to library]
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Mendeley Online Catalogue

④ Suggest

• Mendeley Web suggests articles for you.

・Library comparison with other users documents, subject area, 
or the latest saved documents.
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Group

① Create Groups

• Via Mendeley Desktop or Mendeley Web

Groups Post Documents Browse
Documents

# of Users Share
Documents

Esample

Private Invited Users Invited Users 3 (Free Version) PDF Research Project

Invite-only Invited Users Everyone 20 Document Details Share Reading List

Open Everyone Everyone Unlimited Document Details Discussion Group

Either Group 
(Free Version)
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Group

② Private Group（1）

• An owner invites users to join a private group.

User

[Accept] and join the private 
group

Owner
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Group

③ Private Group （2）

• You can share PDF files in a private group, including annotations and highlights.

Copy documents to a 
private group folder, and 
synch.
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Group

④ Invite-only Group

• Communicate research output from a lab, or share a reading list.



Mendeley |    47

Group

⑤ Open Group

• You can share literature information, and discuss.

Join Group

The Number of Documents and Users
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Personal Profile

① Edit Personal Profile

• You can use a personal profile page to communicate your career.

Save your 
publications in 
[My Publications]
folder.
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Personal Profile

② Follow Researchers

• Follow, and see feeds.

Follow, or send 
a message.

Feeds will show updates from 
groups or following researchers.

Search by People
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Author Performance

Stats

• Stats will show performance (downloads and citations) of your publications.

Online Mass Media

Downloads by ScienceDirect Users
Downloads on by Mendeley Users
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Mendeley Desktop and Mendeley Web

Functions Desktop Web

Web Importer × ○

Suggest × ○

Manage PDF Files ○ ×

Citations Style ○ ×

Insert Reference List (MS Word Plug-in) ○ ×

Exclude from Mendeley Web Catalogue ○ ×

User Stats of Documents × ○

Edit Personal Profile × ○

Stats × ○
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User Guide, Helpdesk

• Mendeley Ltd.

- User Guide, Tutorial
http://community.mendeley.com/guide

- FAQ、Questions
http://support.mendeley.com

• エルゼビア・ジャパン株式会社（日本語）

- クイックレファレンスガイド、参考文献スタイルについての情報など
http://www.elsevier.com/jp/online-tools/mendeley/users
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少し高度な利用のヒント

① E-mail、パスワードの変更

• [My Account] → [Account details] で変更可能
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少し高度な利用のヒント

③ Detailsタブに表示する項目

• [Options] -> [Document Details] で追加・変更可能
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少し高度な利用のヒント

④ 詳細検索（項目を限定した検索）

• 検索ボックスの虫眼鏡の右の▼をクリック
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少し高度な利用のヒント

⑤ 重複文献の整理

• 重複文献の候補が表示されるので、必要に応じてマージ
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少し高度な利用のヒント

⑥ PDFのエクスポート、印刷

• 注釈付きでエクスポート、印刷するかどうかを選択可能
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少し高度な利用のヒント

⑦ PDFをAdobe Readerで表示

• PDFのアイコンを右クリックして [Open File Externally] を選択
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少し高度な利用のヒント

⑧ 参考文献のマージ

• 複数の参考文献を選択してから [Merge Citations]
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少し高度な利用のヒント

⑨ 参考文献にURLを含めない

• 文献タイプがWeb Pageの場合にのみURLを含める



Mendeley |    63

少し高度な利用のヒント

⑩ 引用スタイルの編集 (1)

• CSL Editorを使って既存のスタイルをベースに編集可能
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少し高度な利用のヒント

⑪ 引用スタイルの編集 (2)

• CSL Editorで編集後、保存



Mendeley |    65

少し高度な利用のヒント

⑫ 引用スタイルの編集 (3)

• 編集後のスタイルを読み込み
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少し高度な利用のヒント

⑬ BibTexフォーマットでの出力

• [File] → [Export…] から BibTex (*.bib) フォーマットでエクスポート可能

• [Tools] → [Options] → [BibTex] タブで環境設定


